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1 YouTestMe Software Distribution 

YouTestMe is a complex server-based system. It comprises the Ubuntu Linux host operating system, Tomcat 

application server, PostgreSQL database, and utility scripts. They are all packaged in one pre-configured 

Virtual Appliance called Virtual Machine. Virtualization is a popular concept that significantly simplifies 

complex computer systems' distribution, installation, configuration, and maintenance.  

 

Hypervisor software is required to run a Virtual Appliance. The following major hypervisor software 

supports YouTestMe: 

Hypervisor Software Description Price 

Oracle VirtualBox 
Suitable for workstations and 
small to medium servers 

Free Download 

VMware Workstation Pro 
Ideal for workstations and small 
to medium servers.  

Free Download 

VMware ESXi 
Suitable for data centers. Contact 
your system administrator for 
more information. 

Free Download 

 

  

https://www.virtualbox.org/wiki/Downloads
https://www.vmware.com/products/desktop-hypervisor/workstation-and-fusion
https://www.vmware.com/products/cloud-infrastructure/vsphere
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For best performance and reliability, the recommended hypervisor software is VMware ESXi. 

Virtualization is a popular concept in data centers, and it is likely that your organization already has an 

infrastructure with hypervisor software. However, you should check with your system administrators about 

your organization's standard Virtual Machine platform. Free Oracle VirtualBox will be adequate if you don't 

have any.  

Please check Appendix A in this document for more information on the advantages of Virtual Machines. 

2 System Requirements 

2.1 YouTestMe Virtual Machine Hardware Requirements 

Hardware Typical Enhanced 

CPU 4 vCPU cores 8 vCPU cores 

RAM 16 GB 32 GB 

Storage (HDD or SSD) 80 GB 150 GB 

Network Connection Yes Yes 

 

Note that the above requirements are for the YouTestMe virtual machine. To be installed on a workstation 

or small server, a physical device should have at least 8 GB RAM and 50 GB free disk space, more than the 

above requirements. However, suppose you install a virtual machine on a "bare metal" server with 

hypervisors like ESXi. In that case, the above conditions equal what you need to be available on the physical 

server. 

2.2 Network Bandwidth Requirements 

Ensuring optimal network performance is crucial for a seamless and efficient experience on the GetCertified 

application. This chapter outlines the network requirements for users engaging in basic/lightweight tests 

and proctoring-enabled tests, including the integration with our proctoring service. 

 

• Lightweight Test:  

We recommend a minimum network bandwidth of 1 Mbit/s per user for users participating in 

lightweight tests. This estimate is based on typical usage scenarios involving text-based questions 

and minimal multimedia content. 

• Proctoring-Enabled Test: 

The tests include integration with our proctoring service have additional network bandwidth 

requirements. We recommend a minimum of 12 Mbit/s per user for a smooth and secure 

proctoring experience. This higher bandwidth allocation transfers video and audio data to the 

proctoring service. 

A#_Appendix_
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Several factors can influence the network bandwidth required, including the complexity of test content, the 

frequency of interactions, and the presence of multimedia elements. It's advisable to monitor network 

usage during peak periods and adjust bandwidth accordingly. 

Recommendations for Users: 

To ensure an optimal testing experience, we recommend the following: 

• Stable Internet Connection: Users should connect to a stable and reliable internet connection to 

minimize disruptions during the testing session. 

• Pre-Test Network Check: Before starting a test, users can perform a pre-test network check to 

ensure their internet connection meets the recommended bandwidth requirements. 

• Test Environment Considerations: Consider the test environment, especially for proctoring-enabled 

tests, and ensure the necessary bandwidth is available for a smooth proctoring experience. 

3 Delivery Options 

The YouTestMe product package can be shipped as a memory key or downloaded from our secure FTP 

server via the Internet. 

3.1 Memory key 

Memory key (USB) can be sent directly to the customer's address via the post or a similar service. In 

addition, you can find our software packaged as a Virtual Machine with instructional videos and manuals in 

the enclosed memory key. The directory structure is shown in the picture below.  

 

If you received the YouTestMe product package as a memory key, you should skip to Chapter 5. 

  



 YouTestMe Installation and Support Manual 

Page 8 of 61 

4 Download 

You will receive the download link by email. The file size is approximately 4 GB - it should take up to 30 

minutes to download, depending on the internet connection. You should see a file in your workstation's 

"Downloads" folder when the download completes. 
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4.1 Extract Downloaded File 

The file is downloaded in a ".7z" format and needs to be uncompressed using any popular compression tool 

(7zip, WinRAR, etc.). To do that: 

1. Right-click on the file and choose one of the "extract" options.  

 

2. Once the uncompressing process has been completed, you should see the folder containing the 

Virtual Machine's files. 

 

Below is the list of free compression tools that can be used to decompress the YouTestMe Virtual 

Machine file. 

Software Price Download Link 

7zip Free 7-zip 

WinRAR Free WinRAR 

 

Picture 2 

http://www.7-zip.org/download.html
http://www.rarlab.com/download.htm
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5 YouTestMe Virtual Machine Deployment 

For demonstration purposes, we will describe the deployment process in two different environments:  

1. VMware Workstation, VMware ESXi  

2. Oracle's VirtualBox 

5.1 Import YouTestMe using VMware Workstation 

1. In VMware Workstation, choose "File -> Open" 

2. Select the file in OVF format 

 

3. Click Open 

4. In the window below, set the name of your Virtual Machine and the host location where you have 

at least 350 GB of free disk space. You should choose a local disk drive (not a network drive).  
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5. The virtual machine import process can take up to 15 minutes: 

 
 

6. After importing the Virtual Machine, right-click on its name and select Settings -> Options. Make 

sure that "Linux" and "Ubuntu 64-bit" is selected, as shown in the picture below: 
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7. Start the Virtual Machine up by clicking Power on this virtual machine. 

 

8. When the Virtual Machine starts, wait five minutes for all services to start (database, application 

server, Linux services, etc.) 

 

Check the adequate IP address and subnet mask with your network or system administrator. Then, change 

it according to the procedure described in the section Network Configuration. 
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5.2 Import YouTestMe to VMware ESXi using vSphere Client 

YTM Appliance can be deployed on an ESXi server using the following VMware software: 

1. VMware vSphere Web Client 

2. VMware vCenter Server 

 

Please consult your system administrator for the recommended practice in your organization. 

5.2.1 Import YouTestMe via VMware vSphere Web Client 

1. Open any browser on your workstation and try to access the ESXi server web console via the ESXi IP 

address or its domain name: 
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2. Select "Host" from the left menu and start the "Create/Register VM" wizard: 

 
 

3. Select the "Deploy a virtual machine from an OVF or OVA file" option as the creation type: 
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4. Specify a name for the virtual machine and choose virtual files for upload: 

 

5. Select all five virtual files, as shown in the picture below: 
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6. Manifest file "*.mf" serves for the file's integrity verification, and it will not be shown: 

 

7. Select the appropriate datastore if you have more than one created: 
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8. Select deployment options that suit you best or preserve default settings: 

 
 

9. Review your settings and click the "Finish" button to start deployment: 
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10. You can monitor the deployment process under "Recent tasks" located at the bottom of the page: 

 

5.3 Importing YouTestMe Virtual Machine into Oracle VirtualBox 

1. File -> Import Appliance 
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2. Choose the virtual machine to import -> Open -> Next 

a. Click on the "Folder" button to search for the downloaded ".ovf" file: 

 

b. Choose a virtual appliance file to import: 
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c. Check if the file path is correct: 

 

3. Check Appliance settings, change the name, and click "Import": 
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4. When finished, the YTM Appliance will be available in the inventory tab under the name given in 

Step 3. Perform this setting on a Virtual Machine:  

a. VM Settings -> System -> Acceleration -> Paravirtualization Interface -> Set to "Legacy" 

 

b. Click on the "Start" button to start the virtual machine: 
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6 First Login 

Default login parameters can be found in the chapter Change Linux User Password. 

 

7 Text Editors 

You may need to edit some files on the YouTestMe virtual machine to accomplish specific configuration 

settings. The following text editors are available: 

 

Editor Description Example 

vi (or vim) Linux advanced character-based editor vi file_name 

nano More user-friendly character-based editor nano file_name 
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8 Network Configuration 

To complete the following procedure, execute the following commands: 

1. Check the name of the network interface ( default ens32): 

 
 

2. Edit the network configuration file. Update your desired static IP address, DNS server, and gateway 

where appropriate. Update the name of the network interface if necessary. Save and exit the file 

after you have applied your changes. 

 

$ sudo vim /etc/netplan/50-cloud-init.yaml 

 

network: 

  version: 2 

  ethernets: 

    ens33:      // network interface name 

      addresses: 

        - 192.168.1.100/24   // VM static IP / Subnet 

      nameservers: 

        addresses: [192.168.1.1]  // DNS Server 

      routes: 

        - to: default 

          via: 192.168.1.1   // Network Gateway 

  version: 2 

 

3. To apply the new network changes, execute: 

$ sudo netplan try 

 

4. Alternatively, if you run into some issues, run: 

$ sudo netplan --debug apply 

 

5. Confirm your new static IP address by using the command: 
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$ ip a 

Check the official Ubuntu documentation to learn more about configuring Ubuntu Server networking. 

8.1 Network Troubleshooting 

After configuring the server's networking, you should perform a simple network connection test. Values 

that should be changed are listed below: 

# Value Description 

1.  VM_IP The static IP address assigned to the Virtual Machine 

2.  GATEWAY_IP The address of your network gateway 

3.  NET_MASK 
The netmask of your network, usually 255.255.255.0 
in the local network 

4.  NET_INTERFACE Network interface - usually has the prefix "ens" 

8.1.1 Network diagnostics 

Test your network connection by applying the following actions: 

1. Connect to the YouTestMe Virtual Machine 

2. Try to ping any network device DEVICE_IP connected to the same network from the YouTestMe 

Virtual Machine using the following command: 

ping DEVICE_IP  

3. Try to ping VM_IP from any network device connected to the same network: 

ping VM_IP 

4. Try to ping any publicly available server on the Internet from the deployed YTM Virtual Machine, for 

example, Google Public DNS server 8.8.8.8 (only if Internet access is allowed): 

ping 8.8.8.8 

 

If the first or second operation fails, a networking problem is probably related to invalid network 

configuration parameters. Please recheck the specified network parameters and ensure that the VM_IP 

address is not assigned to another device in the same network. 

If only the third test fails (can not ping 8.8.8.8 successfully), there is a possible routing issue. Please contact 

your network administrator for help if the Internet connection is not forbidden for the YouTestMe server. 

  

https://ubuntu.com/server/docs/configuring-networks
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9 Starting YouTestMe Server Application 

The YouTestMe server application will start once the Virtual Machine is turned on. If the network is 

configured correctly, restart the appliance, and the application will be available.  

To restart the appliance, follow the instructions from the Restarting YouTestMe Virtual Machine section. 

To access the application, type the following string in your browser's address bar: 

http://VM-IP:8080/ytm1/login.xhtml 

For example, http://192.168.1.100:8080/ytm1/login.xhtml 

VM-IP represents the IP address parameter configured in the Network Configuration chapter.  

Login information and the instructions for configuring recommended initial settings can be found here. 

 

  

https://wiki.youtestme.com/youtestme/youtestmedoc/Sales/Documentation%20for%20clients/YTM%20GetCertified%20-%20Instructions%20for%20First%20Time%20Use.pdf
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10 Changing Application Default Port 

1. Create a snapshot of the Virtual Machine to revert to the previous configuration if something gets 

corrupted. 

2. Log in as a Linux sudo user and check ports that are currently in use by executing this command: 

$ sudo lsof -i -P -n |grep LISTEN 

3. Choose the port that is not currently used 

4. Log in as Linux user "ytm1"  

5. Edit file: /home/ytm1/ytm/res/ProgramFiles/tomcat/apache-tomcat-
{TOMCAT_VERSION}/conf/server.xml 

6. Change the port in the line below:  

 
7. Save file 

8. Restart Tomcat by executing these two commands: 

a. $ tstop 

b. wait for 10 seconds to allow Tomcat to shutdown gracefully 

c. $ tstart 

9. In case that application does not start: 

a. Reboot VM: 

Log in as a sudo user and execute the command "reboot" 

b. If the reboot does not solve the problem, try a different port or restore the previous 

configuration. 
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11 Tomcat Manager 

Tomcat Manager App is a web application packaged with the Tomcat server and provides us with the basic 

functionality we need to manage our deployed web applications. 

 

To access the Tomcat Manager application, do the following steps: 

 

1. Open any browser and type the following URL: 

 

http://VM-IP:8080 
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2. Access to Tomcat Manager is allowed only from localhost by default for security reasons. To change 

it, do the following: 

 

Edit the following configuration file (Valve component) and specify the IP address of your 

workstation.  

 

$ nano ${HOME}/ytm/res/ProgramFiles/tomcat/apache-tomcat-

{TOMCAT_VERSION}/webapps/manager/META-INF/context.xml 

 

Example: Allow Tomcat manager access from the private IP address 192.168.1.80. 

 

<Valve className="org.apache.catalina.valves.RemoteAddrValve" 

allow="127\.\d+\.\d+\.\d+|::1|0:0:0:0:0:0:0:1|192\.168\.1\.80" /> 

 

3. Click on the "Manager App" button and enter the login credentials shown in the picture below: 
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4. Now, you can easily manage the YouTestMe application from the GUI as an alternative to the Linux 

command executed in the Terminal. 

 

 
 

Note: Check the official documentation for more details about Tomcat Manager functionality. 

  

https://tomcat.apache.org/tomcat-9.0-doc/manager-howto.html
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11.1 Change Login Credentials 

To change Tomcat Manager login credentials, perform the following operation: 

 

1. Login to YouTestMe Virtual Machine as ytm1 user 

 

2. Edit the following configuration file and set up your username and password values. 

 

$ vim /home/ytm1/ytm/res/ProgramFiles/tomcat/apache-tomcat-

{TOMCAT_VERSION}/conf/tomcat-users.xml 

 

 

 

3. Reboot the YouTestMe Virtual machine or restart the Tomcat Server explicitly by executing the 

following command: 

• $ tstop 

• wait 10 seconds for Tomcat gracefully shutdown 

• $ tstart 

11.2 Security Considerations 

The Tomcat Manager application provides a convenient web-based interface for managing, deploying, and 

monitoring web applications on a Tomcat server. Still, it can pose security risks if used in a production 

environment without proper precautions. Key security risks include: 

 

1. Unauthorized Access: The Manager app introduces an additional attack surface, which may expose 

sensitive controls like deployment and configuration management to unauthorized users if not 

properly secured. 

2. Weak Access Controls: Tomcat Manager has limited built-in support for role-based access control, 

which can make it difficult to restrict specific management actions to authorized personnel only, 

increasing the risk of accidental or malicious changes. 
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3. Sensitive Data Exposure: Tomcat Manager can display server information (like memory usage, 

sessions, and threads), which can be valuable to attackers for understanding server load and 

potential vulnerabilities. 

4. Increased Attack Vector: Running the Manager application may expose Tomcat to potential 

exploits targeting the management interface, mainly if the server is accessible from the Internet. 

 

To mitigate these risks, consider the following security recommendations: 

 

1. Restrict Network Access: Limit access to the Manager application by setting up firewalls, using IP 

safelists, or allowing access only through a VPN to prevent exposure to the public Internet. 

2. Enforce Strong Authentication: Use robust credentials with unique usernames and complex 

passwords. Configure SSL/TLS for encrypted communications to prevent credential interception. 

3. Limit Access to Essential Personnel: Assign the Manager role only to essential administrators and 

developers and avoid using shared credentials. 

4. Disable in Production: For high-security environments, consider turning off the Manager 

application in production or replacing it with automated CI/CD tools (such as Jenkins or Ansible) for 

secure, controlled deployments. 

5. Regularly Update Tomcat: Keep Tomcat updated to ensure any known vulnerabilities in the 

Manager application or Tomcat are patched. 
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12 Restore VM State from Snapshot 

Snapshot is a convenient way of creating a light backup of the Virtual Machine so we can easily roll back to 

a specific point in time. The restore procedure for three major virtualization software will be shown below. 

We highly recommend powering off the YTM Virtual Machine before reverting to one of the previous 

states. 

12.1 VMware Workstation 

 

 



 YouTestMe Installation and Support Manual 

Page 33 of 61 

 

12.2 VirtualBox 
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13 Protecting Your System and Data - Good Practices 

Protecting your system and data is of extreme importance. Several easy-to-follow procedures and best 

practices should be used to protect your system and data from various events, such as hardware failure.  

Company system administrators usually do these tasks regularly, and end-users don't need to worry about 

them. However, YouTestMe can run even on desktop computers in small departments. In that case, the 

person responsible for the application should use the best practices written below to ensure that the 

system can be recovered in case of hardware failure or accidental damage.  

13.1 Create Virtual Machine Snapshots 

A virtual machine snapshot is a one-click backup of the current state of your Virtual machine. Everything on 

the Virtual Machine is preserved at the time of the snapshot, and you can revert to that state at any time. 

Snapshots should be created as often as possible; however, it is generally recommended to do it: 

• whenever you have a significant change in data or system settings or  

• every few days 

13.2 Export Virtual Machine File to another computer or disk 

It is necessary because if the Virtual Machine file gets corrupted for some reason (i.e., hardware failure), 

even previously created snapshots may become unusable. It is less likely to happen if the Virtual Machine is 

hosted in the data center with various redundancy systems such as RAID disks, redundant power supply, 

etc. However, it is strongly recommended that this type of backup is regularly created.  

Once a week is recommended, but generally, more often is better.  

13.3 Manage Important Passwords 

Please write down your administrative passwords and store them in a secure place. If they are lost, it is 

impossible to recover UNIX administrative passwords. 

The most critical administrative passwords are listed in the table below.   

Account Description 

root administrative account for the Operating System (Linux) 

postgres administrative user for the database management (PostgreSQL) 

ytmadmin sudo user with administrative privileges (Linux) 
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13.4 Use Administrative Accounts with Caution 

You should never log in to the system using administrative accounts unless you know what you are doing. 

These accounts are there to be used by system administrators to troubleshoot problems with the system.  

 

The YouTestMe system is designed to do maintenance automatically through scheduled jobs; however, it 

may require manual intervention under exceptional and rare circumstances. An example would be installing 

patches or recovering the system after hardware failure where a backup does not exist.  

 

Note that accidentally deleting or changing some critical files may damage the system or data, and the only 

way to recover may be to revert to the previous VM snapshot or backup.  

13.5 Shut down the YTM system gracefully before turning off the Server 

computer 

If the server computer needs to be turned off or restarted, the YouTestMe system should be shut down 

gracefully.  

14 Creating a YouTestMe Standby Site 

For the maximum protection of your data and system availability, you can create the YouTestMe standby 

(mirror) site used as a failover system if the primary system gets unavailable (due to hardware failure or 

similar). 

It can be accomplished by installing two YTM Virtual machines on two servers. One would be the "Primary" 

server used in your production process, and the other would be the "Standby" server.  

The standby server will always run, but users will not access it. The data copy process will run periodically 

on the standby server, and all data will be copied from the primary server. The user can set this copy's 

frequency to be, for example, several times per day, once per day, or a week. More frequent data copying 

may impose a load on the source system and network, so scheduling it for "quiet" time is best.  
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14.1 Scheduling data copy process 

Log in to YouTestMe Virtual Appliance as application user "ytm1" and open the Terminal: 

Execute: 

crontab -e 

Add to crontab file: 

################################################################################## 

# 

# WARNING! USE THE OPTION BELOW ONLY IF THIS IS STANDBY SERVER! 

# Activating this option will delete data on this server, and it 

# will refresh it with data from the Primary server. 

# Below setting will run data copy every day at midnight 

# 

################################################################################## 

0 0 * * * * ${HOME}/ytm/res/Scripts/Unix/ytm/system_upgrade/ytm_copy_db_to_new_vm.sh 

79.127.105.146 5432 ytm123pw ytm1 

Save file exit with "vi" command: ":wq" + ENTER  

Parameters in the command line are:  

1. The IP address of the source VM from where we are copying data 

2. port of the source database (usually "5432") 

3. source database schema where the original data resides 

Note that log files and target database backup are stored in the following directory:  

/ytmdata/ytm_data_pump_dir/ 
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15 YouTestMe System Maintenance 

15.1 Restarting the YouTestMe Virtual Machine 

To complete this procedure, you must be logged in as a sudo user.  

1. Using a terminal, execute the command "sudo reboot" 

 

2. From VMware Workstation, select the virtual machine from the inventory, right-click on it, and 

choose "Power" -> "Restart guest" 
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15.2 Shutting down the YouTestMe Virtual Machine 

To complete this procedure, you must be logged in as a sudo user.  

Before powering off the physical server, the Virtual Machine should be shut down gracefully so server files 

and data are not corrupted.  

1. Using a terminal, execute the command "sudo shutdown -h now": 

 

2. From VMware Workstation, select the virtual machine from inventory, right-click on it, and 

choose "Power" -> "Shut Down Guest" 
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15.3 Creating a Snapshot of the Virtual Machine 

Snapshot is a convenient way of creating virtual machine backups. With snapshots, we can roll back to a 

specific point in time. 

From VMware Workstation, select a virtual machine from inventory, right-click on it, and choose 

"Snapshot" -> "Take Snapshot" 

 
 

15.4 Creating Export (Physical Backup) Of Virtual Machine 

Virtual Machine Export is the ultimate physical backup. It should be done regularly and kept in a safe place. 

If Virtual Machine files get corrupted, it may not be possible to roll back to previous snapshots, so it is 

essential to make these backups regularly. 

Using this type of export, you can also move or clone YouTestMe virtual machines. Cloning should be done 

only for backup. Backup files can be used to import Virtual Machine at the same or different location using 

the procedure explained in installing the YouTestMe Virtual Machine chapter.  
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1. From the vSphere web client (VMware), select the virtual machine from the list and navigate to 

Actions -> Export: 

 

2. Confirm the operation by clicking the "EXPORT" button: 

 

3. To turn off pop-up blocking or to exclude the host's IP or FQDN from being blocked, follow the 

instructions for your web browser: Chrome or Firefox 

https://support.google.com/chrome/answer/95472?hl=en
https://support.mozilla.org/en-US/kb/pop-blocker-settings-exceptions-troubleshooting?redirectslug=Pop-up+blocker&redirectlocale=en-US
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15.5 Export Database Data to a File 

It is a good practice to back up your data occasionally by exporting them into a file. Then, the file can be 

downloaded and stored in a safe place. In addition, it can be helpful in data loss because the saved user 

data can be imported into the database (check the picture below). 

Navigate to the System -> Maintenance page to execute database data export to a file within the 

application. 
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15.6 Import Database Data from a File 

The PostgreSQL data file can be restored from the backup via CLI (command-line interface) by performing 

the following procedure: 

 

1. Copy your data file (ytm1-backup.dmp, for example) to YTM Virtual Machine and place it in the 

following directory:  

 

/ytmdata/ytm_data_pump_dir/ 

 

The file can be migrated using any SFTP client software like WinSCP or FileZilla. 

 

2. Log in to YTM Virtual Machine as user "postgres" and navigate to the directory where you 

transferred the database backup file : 

 

$ cd /ytmdata/ytm_data_pump_dir/ 

 

3. Backup your current database data (schema):  

 

pg_dump -v -U ytm1 -n ytm1 -b -Fc ytmdb1 > ytm1-backup2.dmp 

 

4. Drop database schema "ytm1": 

 
psql -U ytmadmin -d ytmdb1 -c ‘drop schema ytm1 cascade’; 

 

5. Restore user data from the backup file "ytm1-backup.dmp": 

 

pg_restore -U ytmadmin -d ytmdb1 < ytm1-backup.dmp 
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15.7 Database Parameters 

Table showing default database parameters: 

Setting  Value 

Statistics gathering  automatic 

Database Name ytmdb1 

YTM database administrative user  ytmadmin 

YTM database schema (user data) ytm1 

Character Set UTF8 

Time Zone UTC 

Database Port 5432 

Log Rotation automatic 
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16 Securing network access to the YouTestMe system 

This section describes ensuring that only specific computers on your network can access the YouTestMe 

system.  

16.1 YouTestMe Virtual Machine Active Ports 

Port Protocol Purpose 

22 SSH System support 

5432 TCP Access to the PostgreSQL database 

8080 HTTP Access to the YouTestMe Web Application through a web browser 

 

Linux bash commands that can be used to determine listening ports: 

1. netstat –tulnp 

2. ss –nutlp 

3. lsof -i 

16.2 Assumptions 

All computers are on the local network. 

16.3 Step #1 - Determine a set of IP addresses with Access to the YouTestMe 

System 

Determine the range of IP addresses permanently assigned to computers (devices) that will have access to 

the YouTestMe System. For example, suppose you have 30 computers (workstations) used for doing tests 

and for the application's administration. In that case, you could specify a range of related IP addresses from 

192.168.1.100 to 192.168.1.129. 
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16.4 Step #1 - Collect MAC addresses 

Collect MAC addresses from all computers (devices) that need access to the YouTestMe system. 

Type "ipconfig /all" inside the DOS Window and search for Physical Address (picture below). 

 

16.5 Step #3 - Set up your network (DHCP server) 

Set up your DHCP server to reserve specific IP addresses to specific MAC addresses.  

An example of one particular router (Asus RT-AC66U) is shown below:  
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16.6 Step 4 - Verify your devices 

Reboot your devices and make sure they are assigned IP addresses as set up in Step #3 

16.7 Set up networking in the YouTestMe application 

Set up access to the YouTestMe application to be allowed for IP ranges from 192.168.1.100 to 

192.168.1.129. 

Navigate to "System -> Settings and customization -> System preferences" tab, and locate the "Internal 

network" settings, where you can set a range of your local IP addresses. 
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17 Configure HTTPS Using Apache HTTPD (Ubuntu) 

Requirements: 

1. Apache HTTPD 

2. Apache module mod_ssl 

3. SSL certificate for your domain/subdomain 

17.1 Copy Your SSL Certificate to the Apache Server 

1. SSH to your web server 

2. Switch to sudo/root user  

3. Copy your certificate file, the certificate key, and the certificate of the CA that signed the SSL 

certificate to the following directory: /etc/ssl/certs 

17.2 Add Virtual Host to Apache HTTPD 

1. Navigate to the following directory:  

$ cd /etc/apache2/sites-enabled 

 

2. Create a "httpd-vhosts.conf" file with a Virtual Hosts (your domain/subdomain should replace 

getcertified.example.com). The “secret” value should be the same as it is specified  

 
<VirtualHost *:80> 

 ServerName    getcertified.example.com 

 Redirect  / https://getcertified.example.com/ 

</VirtualHost> 

 

<VirtualHost *:443> 

 

ServerName    getcertified.example.com 

 

SSLEngine on 

SSLCertificateFile /etc/ssl/certs/YOUR_CERTIFICATE.crt 

SSLCertificateKeyFile /etc/ssl/certs/YOUR_key.key 

SSLCACertificateFile /etc/ssl/certs/YOUR_CA.ca-bundle 

 

ProxyPreserveHost on 

 

RewriteEngine on 

    RewriteCond %{REQUEST_URI} ^/$ 

   RewriteRule (.*) /ytm1/ [R=301] 

 

      RewriteCond %{HTTP:Upgrade} websocket [NC] 

      RewriteCond %{HTTP:CONNECTION} Upgrade$ [NC] 

      RewriteRule /(.*)  ws://YTM_VM_IP:8080/$1 [P,L] 

  

   ProxyPass  /ytm1/ ajp://YTM_VM_IP:9101/ytm1/ secret=your_secret 

   ProxyPassReverse  /ytm1/ ajp://YTM_VM_IP:9101/ytm1/  
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</VirtualHost> 

3. Check HTTPD for syntax errors: 

$ apachectl configtest 

 

4. Reload HTTPD: 

$ apachectl graceful 

 

5. Edit the Tomcat configuration file "server.xml" and change the default value for the "secret" 

parameter within the AJP connector settings. The new secret value should match the value 

specified in the Apache virtual host. Restart the Tomcat server to apply the changes. 

 
$ vim /home/ytm1/ytm/res/ProgramFiles/tomcat/apache-tomcat-{TOMCAT_VERSION}/conf/server.xml 

 

<Connector protocol="AJP/1.3" 

address="0.0.0.0" 

          port="9101" 

      secretRequired="true" 

       secret="your_secret" 

       redirectPort="8443" 

         maxParameterCount="1000"  

/> 

18 Ensuring Stability and Reliability of the System 

You can do several things to ensure that the system is running without interruptions:  

1. Monitor disk space usage and memory usage on the host server 

2. Monitor disk space usage and memory within the YouTestMe Virtual Machine 

3. Install the latest patches for your host operating system and hypervisor software; however, ensure 

you can revert to previous versions in case of compatibility issues. 
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19 Getting YouTestMe System Support 

Basic and Advanced support services are included for free in the first year, and after that, they are based on 

a chosen support plan.  

19.1 Without Remote Access 

In case our technical support team doesn't have access to your infrastructure, you can use the following 

support: 

1. User Manuals (Basic) 

2. Technical Documentation (Basic) 

3. Email (Basic) 

4. Video Tutorials (Basic) 

5. Phone (Advanced) 

6. Personal, on-demand video tutorials (Advanced) 

19.2 With Remote Access 

1. Crisis management (Basic) 

2. On-site training (Advanced) 

3. On-site maintenance (Advanced) 

4. Personnel Administrators (Advanced) 

5. Troubleshooting by our technical support team (Advanced) 

19.2.1 Webex Support 

Our support team can help you using the Cisco Webex meeting platform if remote access is possible. With 

Webex, you can share the screen with our support team, and they can guide you on which actions to take, 

leaving you complete control over your system.  

19.2.2 About Webex Meetings 

• Cisco Webex is a web-based application used for conference calls and video presentations. Multiple 

people from different locations can participate in a ring.  

• You will need a web browser, speakers or headphones, and an Internet connection to participate in 

the call. 

•  A microphone is optional, depending on whether you will listen to the presentation or participate 

in the discussion. 

• If you are unfamiliar with this tool, watch our video tutorial (linked here). 

 

 

 

https://youtu.be/AXxUhaRl7XU
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20 Troubleshooting 

20.1 Virtual Machine Freezes 

When a virtual machine freezes, the reason is usually that the host server is running out of memory or disk 

space. The solution is to shut down some processes on your host server or add more memory. If the cause 

runs out of disk space on the host server, adding disk space or cleaning unnecessary files will solve it.  

20.2 Checking Tomcat Log 

To complete this procedure, you must be logged in as a "ytm1" user. 

In most cases, there will be a problem with the YTM application. There are two aliases set up to make 

checking the Tomcat log easier and faster:  

1. tlog ytm1 (the command will open the log with the vim text editor, and you 

can examine the entire log) 

2. tlogt ytm1 (the command will open the log tail and monitor the changes in 

real-time – default ten lines) 

 

Aliases are defined as:  
alias tlog='vim /home/ytm1/ytm/res/ProgramFiles/tomcat/apache-tomcat-{TOMCAT_VERSION}/logs/ytm1.log' 

alias tlogt='tail -f /home/ytm1/ytm/res/ProgramFiles/tomcat/apache-tomcat-

{TOMCAT_VERSION}/logs/ytm1.log' 

20.3 Tomcat could not be stopped 

To complete this procedure, you must be logged in as a "ytm1" user. 

Use the command "istomcat" to see if Tomcat is running.  

Sample output:  

ytm1      6341     1  2 Jan06 ?        17:07:31 /usr/lib/jvm/adoptopenjdk-8-hotspot/bin/java -

Djava.util.logging.config.file=/home/ytm1/ytm/res/ProgramFiles/tomcat/apache-tomcat-{TOMCAT_VERSION}/conf/logging.properties -

Djava.util.logging.manager=org.apache.juli.ClassLoaderLogManager -Xms6144M -Xmx6144M -Xmn1024M -Djdk.tls.ephemeralDHKeySize=2048 -

Djava.protocol.handler.pkgs=org.apache.catalina.webresources -Dorg.apache.catalina.security.SecurityListener.UMASK=0027 -

Dignore.endorsed.dirs= -classpath /home/ytm1/ytm/res/ProgramFiles/tomcat/apache-tomcat-

{TOMCAT_VERSION}/bin/bootstrap.jar:/home/ytm1/ytm/res/ProgramFiles/tomcat/apache-tomcat-{TOMCAT_VERSION}/bin/tomcat-juli.jar -

Dcatalina.base=/home/ytm1/ytm/res/ProgramFiles/tomcat/apache-tomcat-{TOMCAT_VERSION} -

Dcatalina.home=/home/ytm1/ytm/res/ProgramFiles/tomcat/apache-tomcat-{TOMCAT_VERSION} -

Djava.io.tmpdir=/home/ytm1/ytm/res/ProgramFiles/tomcat/apache-tomcat-{TOMCAT_VERSION}/temp org.apache.catalina.startup.Bootstrap start 

Use the command "tstop" to stop the Tomcat server.  

After issuing the tstop, check if Tomcat is still running. If it is still running after several minutes, use the 

"kill" command to kill the process: kill -9 6341  

Note that "6341" is a Unix process ID in the command "istomcat" output. 
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20.4 System Resources 

1. check minimal required system resources (RAM, Disk, CPU) 

command "free -m -h" 

command "cat /proc/meminfo" 

2. check free disk space on all file systems 

use the command "df -h" 

20.5 How to Collect Important System Information from VM 

Navigate to the "System -> Maintenance" page in the application and select the "Diagnostics" tab to collect 

relevant system information: 
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20.6 How to fix VirtualBox Clipboard not working 

To complete this procedure, you must be logged in as "root" user. 

Kill VBoxClient:  

[developer@localhost ~]$ ps -ef|grep clip 

503       5140     1  0 14:07 ?        00:00:00 /usr/bin/VBoxClient --clipboard 

503       5141  5140  0 14:07 ?        00:00:00 /usr/bin/VBoxClient --clipboard 

503       5174  5075  0 14:09 pts/0    00:00:00 grep clip 

[developer@localhost ~]$ 

kill -9 5140 

kill -9 5141 

Stat again VBoxClient with: 

/usr/bin/VBoxClient –clipboard 

The "vboxclient" client runs in the background by default. 

20.7 How to add an optical drive in VirtualBox 

In some cases, the optical drive gets detached from the virtual machine. To attach an optical drive, follow 

the steps: 

1. Select the virtual machine from the inventory on the left and choose "Settings" 
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2. Choose "Storage" and choose "Add an optical drive" 

 

3. Choose "Leave empty": 

 

This question often arises when importing a virtual machine into VirtualBox that was previously exported 

from VMware. 
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20.8 Antivirus software 

20.8.1 The system scanning using ClamAV 

To scan the system using ClamAV antivirus software, run the following command, check the "/home" 

directory, and output only infected files. Then, ring a bell when they are found. The process may take a 

while. 

$ clamscan -r --bell -i /home 

To update the ClamAV antivirus database, run the following command: 

$ freshclam 

20.8.2 Automatic Anti Virus Scanning 

In the YouTestMe virtual machine, antivirus software is scheduled to run automatically every Sunday at 

midnight. 

Anti Virus log files are located in the following directory: 

/ytmdata/clamav_logs/ 

20.9 Troubleshooting VMware Workstation 

20.9.1 VM shuts down on its own after a period of inactivity 

Uncheck the "Keep VMs running after workstation closes" in the Edit -> Preferences -> Workspace tab and 

shut the server down. Once it is back up, re-enable the "Keep VMs running after workstation closes". 

20.9.2 Collecting diagnostic information for VMware Workstation 

https://kb.vmware.com/selfservice/search.do?cmd=displayKC&docType=kc&docTypeID=DT_KB_1_1&exter

nalId=1346 

20.10 Troubleshooting Ubuntu Linux Host 

20.10.1 Diagnostic techniques 

Examine system logs in /var/log/ 

Examine kernel messages dmesg | more 

Use "sos report" sos report -l 

https://kb.vmware.com/selfservice/search.do?cmd=displayKC&docType=kc&docTypeID=DT_KB_1_1&externalId=1346
https://kb.vmware.com/selfservice/search.do?cmd=displayKC&docType=kc&docTypeID=DT_KB_1_1&externalId=1346
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21 Configuration Procedures 

21.1 Utility Software 

List of software used to administer YouTestMe products. Depending on the system, choose the most 

appropriate of the following: 

Software Description 

VMware Workstation 
Used to run Virtual Machines and change their settings (i.e., increase 

memory or disk space) 

OpenSSH Used to open SSH (Secure Shell) session to VM from Windows workstation 

Terminal Used to open SSH (Secure Shell) session to VM from MacOS workstation 

21.2 Change Linux User Password 

To complete this procedure, you must be logged in as a sudo user. 

To log in as the root user via Terminal, execute the following command and enter the password afterward:  

$ sudo su 

Default Linux passwords: 

Username Password Role 
root not configured Linux administrator 

postgres 2ytm1 YouTestMe database user 

ytm1 2ytm1 YouTestMe application user 
 

The "#" sign in front of the command means the root user is logged in and will execute the following 

command. 

The "$" sign in front of the command indicates that the regular user is logged in and will execute the 

following command. 

  

http://www.vmware.com/products/workstation.html
https://learn.microsoft.com/en-us/windows-server/administration/openssh/openssh_install_firstuse?tabs=gui
https://support.apple.com/guide/terminal/open-or-quit-terminal-apd5265185d-f365-44cb-8b09-71a064a42125/mac
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21.2.1 Changing password using SSH Terminal 

To change the password for the Linux user:  

1. execute the command "passwd username" 

2. enter a new password  

3. confirm by pressing the key "Enter" 

  

Example: 

# passwd ytm1 

 

Test new password by logging in as a newly configured user: 

# su – ytm1 

21.3 Change PostgreSQL Database Administrator's Passwords 

The default password for the database administrative account listed in the table below should be changed. 

Username Role 

postgres PostgreSQL native database 
administrator 

ytmadmin PostgreSQL YouTestMe database 
administrator 

 

Essential: write down new passwords and store them in a secure place. Ensure you don't lose them since it 

may be impossible to recover them except by restoring the backup or snapshot system. 

To complete this procedure, you need to be logged in to Linux as the "postgres" user. 

Changing passwords for database users "postgres" and "ytmadmin" is highly recommended when installing 

the system. To do that, you will need to log in as user "postgres" into the Linux system and log into the 

database as user "psql" (see example below): 

$ psql 

postgres=# ALTER USER ytmadmin WITH PASSWORD 'new_password'; 

postgres=# ALTER USER postgres WITH PASSWORD 'new_password'; 
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21.4 Install VMware Tools 

To complete this procedure, you must be logged in as a sudo user. 

If YouTestMe Appliance is deployed using VMware products, it is advised to install VMware tools. 

1. Go to Virtual Machine > Install VMware Tools (or VM > Install VMware Tools). 
 
Note: If you are running the light version of Fusion, or a version of Workstation without VMware 
Tools, or VMware Player, you are prompted to download the Tools before they can be installed. 
Click Download Now to begin the download. 
  

2. In the Ubuntu guest, run these commands: 
  

1. Run this command to create a directory to mount the CD-ROM: 
 
$ sudo mkdir /mnt/cdrom 
 
When prompted for a password, enter your Ubuntu admin user password. 
 
Note: For security reasons, the typed password is not displayed. You do not need to enter 
your password again for the next five minutes. 
  

2. Run this command to mount the CD-ROM: 
 
$ sudo mount /dev/cdrom /mnt/cdrom or sudo mount /dev/sr0 /mnt/cdrom 
  

3. The file name of the VMware Tools bundle varies depending on your version of the VMware 
product. Run this command to find the exact name: 
 
$ ls /mnt/cdrom 
  

4. Run this command to extract the contents of the VMware Tools bundle: 
 
$ tar xzvf /mnt/cdrom/VMwareTools-x.x.x-xxxx.tar.gz -C /tmp/ 
 
Note: x.x.x-xxxx is the version discovered in the previous step. 
  

5. Run this command to change directories in the VMware Tools distribution: 
 
$ cd /tmp/vmware-tools-distrib/ 
  

6. Run this command to install VMware Tools: 
 
$ sudo ./vmware-install.pl 
 
Note: Press Return to accept each default or supply your answers. 
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3. Run this command to reboot the virtual machine after the installation completes: 
 
$ sudo reboot 

 

21.5 Upgrading Ubuntu Linux Operating System 

To install the latest patches to your operating system, log in as sudo user and execute:  

$ sudo apt update - updates the list of available packages and their versions but does not install or 

upgrade any packages. 

$ sudo apt upgrade - installs newer versions of the packages you have. After updating the lists, the 

package manager knows about available updates for your installed software. 
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22 Appendix "A" - Virtual Machine Explained 

There are many advantages of using the concept of Virtual Machines: 

1. Very complex computer systems are packaged in pre-configured in one VM and hence very easy to 

install 

2. The virtual machine is independent of the underlying operating system 

3. It is easy to assign additional virtual memory or virtual disk space to a Virtual Machine 

4. Backup and restore of the entire system is straightforward 

5. Moving a Virtual Machine from one server to another is fast and convenient 
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23 VM Advantages 
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24 VM Concepts 

24.1 Physical Server with Operation System 

 

24.2 "Bare Metal" Physical Servers 

"Bare Metal" Physical Servers do not have an underlying Operating System. Instead, hypervisor software is 

installed directly on the hardware platform.  

 


